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What is the National Transit Database? 

The National Transit Database (NTD) was established by Congress to be the Nation’s primary source for 
information and statistics on the transit systems of the United States. Recipients or beneficiaries of grants from 
the Federal Transit Administration (FTA) under the Urbanized Area Formula Program (§5307) or the Other than 
Urbanized Area (Rural) Formula Program (§5311) are required by statute to submit data to the NTD. Over 750 
transit providers in urbanized areas currently report to the NTD through the Internet-based reporting system. 
Each year, NTD performance data are used to apportion over $5 billion of FTA funds to transit agencies in 
urbanized areas (UZAs). Annual NTD reports summarizing transit service and safety data are submitted to 
Congress. 

The legislative requirement for the NTD is found in Title 49 U.S.C. 5335(a): 

SECTION 5335 National transit database 

(a) NATIONAL TRANSIT DATABASE — To help meet the needs of individual public transportation 
systems, the United States Government, State and local governments, and the public for information on 
which to base public transportation service planning, the Secretary of Transportation shall maintain a 
reporting system, using uniform categories to accumulate public transportation financial and operating 
information and using a uniform system of accounts. The reporting and uniform systems shall contain 
appropriate information to help any level of government make a public sector investment decision. The 
Secretary may request and receive appropriate information from any source. 

(b) REPORTING AND UNIFORM SYSTEMS — the Secretary may award a grant under Section 5307 or 
5311 only if the applicant and any person that will receive benefits directly from the grant, are subject to 
the reporting and uniform systems. 

The NTD reporting system evolved from the transit industry-initiated Project FARE (Uniform Financial 
Accounting and Reporting Elements). Both the private and public sectors have recognized the importance of 
timely and accurate data in assessing the continued progress of the nation's public transportation systems. 

Funding for Transit Agencies Serving Urbanized Areas under 200,000 Population  
The NTD data are used in the formula allocations of federal transit funds. For urbanized areas with a population 
over 200,000, NTD data are used in the formula allocation of federal transit funds for the Urbanized Area 
Formula Program (§5307), the State of Good Repair Program (§5337), and for the Bus and Bus Facilities 
Formula (§5339). NTD data for urbanized areas with populations fewer than 200,000 are also used in the 
allocation of federal transit funding. 

For urbanized areas with a population under 200,000, 1.5% of the funds for Section 5307 are allocated 
according to the Small Transit Intensive Cities (STIC) formula. Under the formula for STIC, funds are 
apportioned to UZAs with populations fewer than 200,000 that meet or exceed the average level of service for 
all UZAs with populations between 200,000 and 1,000,000 for one of more of the following six measures, all of 
which use reported NTD data: 

• Passenger miles traveled per vehicle revenue mile; 

• Passenger miles traveled per vehicle revenue hour; 

• Vehicle revenue miles per capita; 

• Vehicle revenue hours per capita; 

• Passenger miles traveled per capita; and 

• Passengers per capita. 

For more information on the FTA funding program for urbanized areas, contact your regional administrator or go 
to www.fta.dot.gov. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G167
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G167
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G503
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G500
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G170
http://www.fta.dot.gov/
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Reporting Modules 
The National Transit Database (NTD) Reporting Manual is divided into five reporting modules, each comprised 
of a series of data modules, as described below: 

NTD Urban Reporting Manual, which includes: 

• Basic Information Module; 

• Financial Module; 

• Asset Module; 

• Service Module; 

• Resource Module; 

• Federal Funding Allocation Statistics Module; and 

• Declarations; 

NTD Small Systems Waiver Reporting Manual, which includes: 

• Basic Information Module; 

• Asset Module; 

• Small Systems Module; 

• Federal Funding Allocation Statistics Module; and 

• Declarations; 

NTD Monthly Reporting Manual, which includes: 

• Monthly Ridership forms; 

NTD Safety and Security Reporting Manual, which includes: 

• Safety and Security forms; and 

• Chief Executive Officer Certification; and 

NTD Rural Reporting Manual (exclusively rural reporters), which includes: 

• Rural forms.  
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Exhibit 1 — NTD Contact Information 

Mailing Address  

You can write to the FTA NTD Project Office at the following 
address: 

Federal Transit Administration 
National Transit Database Program 
943 Glenwood Station Ln 
Suite 102 
Charlottesville, VA 22901 

Telephone 

You can contact your NTD validation analyst and other NTD staff 
by telephone on weekdays. For telephone information and project 
assistance, call the NTD Help Desk at: 

1-888-252-0936 

The NTD Help Desk is open from 8:00 am to 7:00 pm (Eastern 
Time). If your NTD validation analyst is unavailable, you may use 
the voice-mail system and your validation analyst will return your 
call. 

 

Please note that all official correspondence should be 
scanned and submitted to the NTD via the e-File tab in 
Internet Reporting. 

E-mail 

You can contact your NTD validation analyst by using the 
telephone number or e-mail address located on the Home tab at: 

www.ntdprogram.gov  > Internet Reporting Login > 
Announcements 

You can email the NTD Help Desk at any time at 
NTDhelp@dot.gov 

Internet 

The FTA NTD Project Office manages a website at the following 
address: 

www.ntdprogram.gov 

You may e-mail comments, questions or suggestions to the NTD 
by clicking on the NTD Feedback link.  

NTD publications, data and reference documents are available on 
the FTA NTD website by using the NTD Reference Materials and 
Access NTD Data links. 

Reference Information 

Transit Terminology and Parameters 
Reporting data to the NTD requires an understanding of the following transit concepts and terms: 

• Transit Agency 

• Public transportation  

• Mode 

• Type of service (TOS) 

Each of these terms is described in further detail in the sections that follow. 

Transit Agency 
A transit agency is responsible for the provision of public transportation service. The transit agency can provide 
the service using its own employees to operate the vehicles (directly operated service) or contract with a public 
or private provider to operate the transit vehicles and employ the vehicle operators (purchased transportation 
service). With some exceptions, transit agencies typically are public bodies and generally are the NTD reporting 
agencies for their DO and PT services. 

Public Transportation 
The NTD is established by law as a repository of information on public transportation. The term “public transportation” is 
synonymous with the terms “transit” and “mass transportation” and is defined by law at 49 U.S.C. 5302(a) (10).  

http://www.ntdprogram.gov/
mailto:NTDhelp@dot.gov
http://www.ntdprogram.gov/
http://www.ntdprogram.gov/ntdprogram/feedback.jsp
http://www.ntdprogram.gov/ntdprogram/reference.htm
http://www.ntdprogram.gov/ntdprogram/data.htm
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(10) PUBLIC TRANSPORTATION. – The term “public transportation” means transportation by a conveyance that 
provides regular and continuing general or special transportation to the public, but does not include schoolbus, 
charter, or intercity bus transportation or intercity passenger rail transportation provided by the entity described in 
chapter 243 (or a successor to such entity).  

Transit definitional requirements for NTD reporting: 

• Transit must be open to the public. Transit must also comply with the provisions of the Americans with Disabilities 
Act of 1990 (ADA). Services that are only open to specific groups of people are excluded. Examples of excluded 
services include: 

o A bus system sponsored by a university that is only open to students, faculty, and staff of the university; 

o A vanpool sponsored by an employer that only provides service to employees of the employer; 

o An automated guideway in an airport, which only provides services to customers of the airport. 

• Transit includes special transportation, such as complimentary paratransit required by the ADA. Transit also 
includes other shared-ride demand response services, including both sponsored and unsponsored trips. 

• Transit excludes charter service. In accordance with FTA’s Charter Rule, any service reported to FTA’s charter 
registration website must not be treated as public transportation in NTD reports.  

• Transit excludes sightseeing service. Sightseeing service is provided primarily for the enjoyment of sights and 
sounds during the ride, or for enjoyment of the ride itself. Sightseeing service includes services that have narration 
and services where passengers primarily make round-trips without disembarking the vehicle.  

• Transit excludes intercity service. The NTD defines an intercity service as service where a majority of passengers 
are not making a same-day return trip. Thus, for public transportation, a majority of passengers across the totality of 
the service (i.e. all runs on all days of the week) must make a same-day return trip. On public transportation, a 
majority of passengers use the service three or more times a week. 

• Transit excludes Amtrak (the entity described in 49 U.S.C. Chapter 243). NTD reporters must demonstrate that they 
are organizationally separate from Amtrak. This exclusion does not apply to cases where Amtrak is the supplier of 
purchased transportation for commuter rail service.  

Mode 
A mode is a system for carrying transit passengers described by specific right-of-way, technology and 
operational features.  A variety of transit modes are operated in the United States. The NTD reporting system 
groups transit modes into two broad categories — rail and non-rail — as follows: 

Rail Non-Rail 
Alaska railroad (AR) 

Cable car (CC) 

Commuter rail (CR) 

Heavy rail (HR) 

Hybrid Rail (YR) 

Inclined plane (IP) 

Light rail (LR) 

Monorail /Automated Guideway (MG) 

Street Car Rail (SR) 

Aerial Tramway (TR)  

Commuter Bus (CB) 

Bus (MB) 

Bus Rapid Transit (RB) 

Demand Response (DR)  

Demand Response -Taxi (DT) 

Ferryboat (FB) 

Jitney (JT) 

Publico (PB) 

Trolleybus (TB) 

Vanpool (VP) 

Other (OR) 

  

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G29
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G29
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G79
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G439
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G215
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G385
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G284
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Exhibit 2 — Modes of Public Transportation  

Aerial Tramway (TR) Non-Rail – Fixed 
Guideway 

A system of aerial cables with 
suspended vehicles.  

Alaska Railroad (AR) Rail – Fixed 
Guideway 

A special railroad that Congress recognized 
for certain FTA funding that operates in 
Alaska. 

Bus (MB) Non-Rail – Fixed Guideway or 
Non-Fixed Guideway 

 
Fixed-route bus service is the most-
prevalent mode in the country. MB 
service is powered by a motor and fuel 
contained within a vehicle. Deviated 
fixed-route service is also reported as 
MB. 

Bus Rapid Transit (RB) Non-Rail – 
Fixed Guideway or Non-Fixed Guideway 

 

Fixed-route bus systems that operate at 
least 50% of the service on fixed 
guideway. These systems also combine 
passenger stations, traffic signal priority 
or pre-emption, low-floor vehicles or 
level-platform boarding, and separate 
branding of the service. This is often a 
lower-cost alternative to light rail. 

Cable Car (CC) Rail – Fixed Guideway  

 
A railway propelled by moving cables 
located beneath the street. While popular at 
the turn of the last century, the only 
surviving system is operated in San 
Francisco. 

Commuter Bus (CB) Non-Rail – Fixed 
Guideway or Non-Fixed Guideway 

 

Fixed-route bus systems that are 
primarily connecting outlying areas with a 
central city. Service typically uses over-
the-road buses with service 
predominantly in one direction during 
peak periods, limited stops, and routes of 
extended length. 

 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G26
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G28
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G67
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G67a
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G70
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G91a
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Exhibit 2 — Modes of Public Transportation  

Commuter Rail (CR) Rail – Fixed 
Guideway 

 
Rail service operating on either old 
freight railways, or on tracks that are 
shared with freight railways, Amtrak, or 
both. The service is characterized by 
relatively long distances between stops, 
for service primarily connecting a central 
city with outlying suburbs and cities. The 
service may be either diesel or electric-
powered and usually has grade-
crossings with roadways. 

Demand Response (DR) Non-Rail – Non-
Fixed Guideway 

Shared-ride demand response service is 
scheduled in response to calls from 
passengers. Many transit systems operate 
demand response (DR) service to meet the 
requirements of ADA.  

Demand Response – Taxi (DT) Non-
Rail – Non-Fixed Guideway 

A special form of the demand response 
mode operated through taxicab 
providers, but with a system in place to 
facilitate ride sharing. The mode is 
always purchased transportation type of 
service. For Demand Response Taxi to 
be considered public transportation there 
must be an attempt for a shared ride 
program. Voucher Programs are not 
considered public transportation. 

Ferryboat (FB) Non-Rail – Fixed 
Guideway 

 

A mode that carries passengers over 
water. 

Heavy Rail (HR) Rail – Fixed Guideway 

An electric railway that operates local 
service in exclusive right-of-way. The 
service is characterized by long trains of six 
to eight cars or more and by relatively short 
distances between stops for local service 
within a city and the immediate suburbs. 
The Nation’s traditional subway systems 
are classified as heavy rail. 

 

Hybrid Rail (YR) Rail – Fixed Guideway 

 
Rail systems primarily operating routes 
on the National system of railroads, but 
not operating with the characteristics of 
commuter rail. This service typically 
operates light rail-type vehicles as diesel 
multiple-unit trains (DMU’s). 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G92
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G114
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G115a
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G146
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G192
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G199a
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Exhibit 2 — Modes of Public Transportation  

Inclined Plane (IP) Rail – Fixed 
Guideway  

A railway operating on steep slopes and 
grades with vehicles powered by moving 
cables. 

Jitney (JT) Non-Rail – Non-Fixed 
Guideway  

A unique form of bus service using owner-
operated vehicles on fixed routes. 

Light Rail (LR) Rail – Fixed Guideway  

An electric railway that operates local 
service in mixed traffic with road 
vehicles, or has grade crossings with 
roadways. The service is characterized 
by short trains of one to four cars and by 
relatively short distances between stops 
for local service within a city and the 
immediate suburbs. 

Monorail/Automated Guideway (MG) 
Rail – Fixed Guideway  

An electric railway that straddles a single 
guideway. It may have vehicle operators 
or may use computers to guide the 
vehicles. 

Publico (PB) Non-Rail – Non-Fixed 
Guideway  

Publicos are jitney services operated in 
Puerto Rico. 

Streetcar Rail (SR) Rail – Fixed 
Guideway  

 
Rail systems operating routes 
predominantly on streets in mixed-traffic. 
This service typically operates with 
single-car trains powered by overhead 
catenaries and with frequent stops. 

Trolleybus (TB) Non-Rail – Fixed 
Guideway  

Fixed-route service using rubber tire 
buses powered by electric current from 
overhead wires using trolley poles. 
Service using rubber tire replica trolleys 
or historic trolleys, powered by an on-
board motor are not included in this 
mode. 

Vanpool (VP) Non-Rail – Non-Fixed 
Guideway 

 
A commuting service operating under pre-
arranged schedules for previously formed 
groups of riders in vans. 

Other 

If none of the choices fits your agency, 
select the category: Other. Internet 
Reporting will display a box for you to 
describe the other mode. 

 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G202
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G219
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G233
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G269
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G374
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G450a
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G494
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G510
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Type of Service (TOS) 
Public transportation can be provided in two ways: 

1. Directly operated (DO) service – the NTD reporting agency, usually the public transit agency, uses its 
own employees to operate the transit vehicles and provide the transit service. 

2. Purchased transportation (PT) service – the NTD reporting agency, usually the public transit agency, 
contracts with a public or private provider to operate the transit vehicles, employ the operators, and 
provide the transit service.  

Type of Service (TOS) is an important element of NTD reporting. On most reporting forms, transit agencies are 
required to report data by TOS. 

Area Definitions 

The NTD reporting system uses two definitions of area: 

1. UZA, and  

2. Service area. 

UZA is defined by the US Census Bureau based on incorporated places (e.g., cities, towns, villages) and their 
adjacent areas that together form a densely populated area of at least 50,000 persons. UZAs do not conform to 
congressional districts or any other political boundaries. 

The most current UZA designations are based on the 2000 census. The NTD reporting system assigns a unique 
number to each of the UZAs in the country. All transit providers reporting to the NTD must serve at least one 
UZA; many reporters service multiple UZAs, as well as rural areas (non-UZAs) of less than 50,000 persons. The 
Census-defined UZAs are an important part of NTD reporting requirements. Reporters must report selected data 
by UZA number on two forms - the S-20 and the FFA-10. Transit agencies serving UZAs of 200,000 or more 
population must report security data on the Reportable Incident Report form (S&S-50). Finally, UZA size 
determines the sampling requirements for passenger miles traveled (PMT) data reported on the S-10. 

Service area is a measure of access to transit service in terms of population served and area coverage (square 
miles). The reporting transit agency determines the service area boundaries and population for most transit 
services using the definitions contained in the ADA. 

For most transit agencies, the size of the UZA is different from the size of the service area. In many instances, 
the size of the service area will be smaller than the UZA served. In other cases, where there is broad public 
support for transit, the size of the service area is greater than the size of the UZA. These differences can cause 
confusion, since a transit agency's NTD reporting requirements are based on the size of the UZA served and the 
data reported are for the transit agency's service area. 

Maximum Service Vehicles 
The maximum service operated during the year is an important determinant of a transit system's size and 
resulting performance. Transit agencies are required to report data on two measures of maximum service: 

1. Vehicles operated in maximum service (VOMS) 

2. Vehicles available for annual maximum service.  

VOMS is a count of the revenue vehicles scheduled for the peak day and operating period of the peak service 
season or schedule of the year. The revenue count is the typical number of vehicles operated and does not 
consider the number of vehicles operated on atypical days such as holiday celebrations (e.g., Fourth of July), or 
one-time special events (e.g., World Series celebrations, political conventions). 

Vehicles available in annual maximum service are a count of the revenue vehicles available to meet the 
maximum service requirement (revenue vehicles necessary to meet peak demand) for the fiscal year. This 
count of revenue vehicles includes: 

• VOMS 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G306
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G428
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G521
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G399
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• Spare vehicles – revenue vehicles used to accommodate routine maintenance and repair operations, 
and to replace vehicles in scheduled service that breakdown or are involved in accidents. 

The count of vehicles does not include: 

• Vehicles out for extended major repair or rehabilitation 

• Emergency contingency vehicles – inactive revenue vehicles that normally would have been disposed 
of at the end of their useful life. FTA allows transit agencies to retain these vehicles if they are stored 
and maintained, and part of an approved FTA Emergency Contingency Plan. 

Reference Documents 
The FTA Uniform System of Accounts (USOA) and Final Rule (49 CFR Part 630) are essential to understanding the forms 
and instructions presented in this manual. You can obtain these documents, as well as the other reference documents listed 
in Exhibit 5 NTD Reference Documents below, by visiting the NTD Project website at www.ntdprogram.gov or calling the 
NTD Help Desk at 1-888-252-0936. 

Exhibit 3 — NTD Reference Documents 

The Reference documents listed below are available for downloading or viewing from the NTD website: 

• Current Reporting Manuals 

• Annual 

• Safety and Security 

• Monthly 

• Rural 

• Small Systems Waiver Manual 

• NTD Reference Materials 

• NTD Final Rule (49 CFR Part 630) 

• Uniform Crime Reporting Handbook. 

 

Changes in 2014 Monthly Reporting 

In its ongoing efforts to improve upon the NTD Internet Reporting system and to be responsive to the needs of 
transit agencies reporting to the NTD and the transit community, FTA continues to refine and clarify reporting 
requirements and internet reporting. 

Reporting changes for the 2014 NTD are highlighted below. Specific changes are discussed in detail in the 
applicable sections of this manual. 

 

Exhibit 4 — Calendar Year 2014 Reporting Changes and Highlights 

Mode Service Operated form (MR-10): 

1. No Changes. 

Monthly Ridership Reporting form (MR-20): 

1. Clarification on Monthly Ridership Reporting and the Small Systems Waiver (W-30).  

 

  

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G442
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G128
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Who Reports, What, How, When and Where to Report  

Who Reports 
Transit providers, States, or Metropolitan Planning Organizations (MPOs) that receive Urbanized Area Formula 
Program (§5307) grants, or that directly benefit from these grants, must report to the NTD or coordinate the 
submittal of data to the NTD on their behalf. The requirement to report begins in the year after you apply for a 
§5307 Grant, or in the year in which benefits are first received from a §5307 grant, whichever is sooner. The 
reporting requirement lasts for as long as the §5307 remains open, or through the minimum useful life of any 
capital assets purchased with §5307 grant funds, whichever is later.  

Please note that this means that you may be required to report in year in which no §5307 grant funds were 
received. An NTD reporter that is no longer required to report to the NTD, should continue to file NTD reports if 
that reporter intends to apply for a §5307 or a §5311 grant in the future. 

Recipients or direct beneficiaries from Other than Urbanized Area Program (§5311) grants are also required to 
report to the NTD, under the streamlined Rural NTD reporting requirements. Please consult the Rural NTD 
Reporting Manual for more information on these requirements.  

A complete understanding of who must submit an NTD report requires an understanding of the following: 

• Purchased transportation services 

• Consolidated NTD reporters 

• Voluntary reporters 

• Extensions, waivers and special requests 

• Commuter Rail (CR) Operations 

Purchased Transportation Services  
Purchased transportation (PT) service is service provided to a public transit agency or governmental unit from a 
public or private transportation provider based on a written contract. A contractual relationship exists only if all 
the following criteria are met: 

• The seller is obligated, in advance of the time the service is furnished, to provide the operations for 
which the operating statistics are being reported for a specific monetary consideration. 

• A written agreement exists that specifies the contractual relationship for the time period and the specific 
service generating the operating statistics included in the NTD Annual report. 

• The written agreement is signed by authorized representatives of both the buyer and the seller, and 
details the services to be provided, and the nature and amount of the monetary consideration. 

Granting a transportation provider permission to operate certain services through a franchise or license does 
not, in itself, constitute PT. Also, management services contracts, in which all or some personnel or services are 
provided to manage or operate the transit agency, are not considered PT. Generally, the service is part of the 
public transit agency’s DO service. 

Cooperative agreements between public transit agencies or governmental units should not be reported as PT 
services. 

The NTD operates under a “you buy it, you report it” rule. Thus, sellers of purchased transportation services do 
not report directly to the NTD – the agency purchasing the service (buyer) generally reports data for the service.  

For the most part, the NTD does not recognize agreements or memorandums of understanding between two 
public agencies as “purchased transportation services.” In these cases, the two public agencies should establish 
which one will report the service (as a directly operated service) to the NTD.. 

Please see Contractual Relationship form (B-30) in the Basic Information Module of the Annual Reporting 
Manual for further discussion on reporting PT services. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G371
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G268
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G101
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G427
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Consolidated NTD Reporters 
Consolidated NTD reporters are a collection of transit agencies filing one report. One reporter may file a 
consolidated report on behalf of other reporters if it is easier to collect and control the quality of the data. This 
often occurs when one transit agency coordinates the development and funding of public transportation services 
in an area. Transit agencies filing a consolidated report must operate within the same UZA.  

Transit agencies that wish to file a consolidated report must submit a request to FTA in writing. Such requests 
for consolidations are subject to FTA approval and must include the following:  

• Names of all transit agencies to be included 

• Fiscal year end dates for the transit agencies 

• Previous/current NTD identification numbers (NTD IDs) of the transit agencies, as appropriate 

• Fiscal year to be covered for the first consolidated report 

Consolidation requests are subject to review and approval by FTA and are not granted automatically. FTA will 
notify you, in writing via the e-File tab, if your request is approved.  

Voluntary Reporters  
FTA encourages all providers of transit service in urbanized areas to report to the NTD, regardless of whether 
they are public or private, and whether or not they receive or benefit from §5307 grants. To be accepted as a 
voluntary reporter in the NTD, you must be a provider of transit services in at least one urbanized area (UZA), 
and be able to comply with all of the NTD reporting requirements and the Uniform System of Accounts (USOA). 
All urbanized area NTD reporters are required to comply with all NTD requirements for the Annual, Monthly, and 
Safety & Security Modules. Please refer to the Annual Reporting Manual and the Safety & Security Reporting 
Manual for information on the reporting requirements of those modules. 

Waivers 
Transit agencies can request seven different types of waivers for relief from certain reporting requirements.  
Three of these waivers affect whether or not your agency must report monthly ridership data.  Those waivers 
are: 

Small Systems Waiver – 30 or Fewer Vehicles 

A transit provider that operates 30 or fewer vehicles in annual maximum service (VOMS) across all modes for 
both directly operated (DO) and purchased transportation (PT) services and operates all service on non-fixed 
guideway may submit a report with significantly reduced reporting requirements.  The reporting requirements for 
this waiver can be found in the separate Small Systems Waiver Reporting Manual. 

Grants Waivers for Planning and Capital 
An organization that receives or benefits from Section 5307 funds, but does not have any transit operations, 
may request a waiver from certain NTD reporting requirements.  Typically, this organization is using the Section 
5307 funds for planning or capital investment.  Transit operations must request this waiver each year.   

Natural Disaster Waiver  
A transit provider that is severely impacted by a natural disaster may request a waiver from reporting to the NTD 
for the current year.  A request for a natural disaster waiver must demonstrate that the natural disaster was so 
severe as to prevent the actual collection and reporting of data, or that the actual collection and reporting of data 
would constitute an unreasonable burden on the transit agency in light of the natural disaster.  Disaster waivers 
are only granted for one year.  

For more information on waivers, please refer to the Annual Reporting Manual. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G292
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G371
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G367
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G526
http://www.ntdprogram.gov/ntdprogram/pubs/SmallSystems/2011/html/2011_SSW_Reporting_Manual_Table_of_Contents.htm
http://www.ntdprogram.gov/ntdprogram/pubs/ARM/2011/html/2011_Reporting_Manual_Table_of_Contents.htm
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Levels of Access 
The system provides six levels of access to the NTD Program.  Transit agencies designate the individuals within 
their organizations who are responsible for entering data into the NTD program.  These access levels are 
assigned on the B-20 (Contacts) form located on the Annual tab.    

CEO: Edit, save, and submit in all reporting areas (Annual, Monthly, and Safety and Security), as well as all 
CEO certifications.  

NTD contact: Edit, save, and submit in all reporting areas (Annual, Monthly, and Safety and Security). 

NTD editor: Edit and save in all reporting areas (Annual, Monthly, and Safety and Security). 

NTD viewer: View all reporting areas (Annual, Monthly, and Safety and Security). 

Safety contact: Edit, save, submit and delete in the Safety and Security reporting area only.  

Safety editor: Edit and save in the Safety and Security reporting area only. 

Safety viewer: View the Safety and Security reporting area only. 

Security contact: View the Safety and Security reporting area only. 

 

User Names and Passwords 
The system access level is determined by the user name.  The first portion of the user name defines the access 
level and the last four digits represent the agency’s NTD ID number: 

• CEO — CEO#### 

• NTD contact — NTD#### 

• NTD Editor — EDT#### 

• NTD Viewer — VWR#### 

• Safety contact— SFTYNTD#### 

• Safety editor — SFTYEDT#### 

• Safety viewer — SFTYVWR#### 

• Security contact— SECURITY####  

 

FTA e-mails each agency this set of user names with a password for each.  

A user can change his / her password at any time. For additional information on this topic, refer to the Sys 
Admin tab section within this manual titled: Changing Your Password. Please be aware that passwords expire 
every sixty days.  In addition, the system now has an inactivity lock-out feature if you do not log in under your 
user name for sixty days.  

If you forget your password, or are locked out due to inactivity, contact your Analyst or the NTD Help desk.  

Note: The system can e-mail passwords only to the addresses listed on the Contacts form (B-20). 

What to Report 
The NTD Monthly Report consists of a series of forms that collect data providing FTA with monthly trends in 
ridership and service supplied throughout the year. It must contain all the public transportation service, including 
complementary paratransit services required by the Americans with Disabilities Act of 1990 (ADA), which the 
transit agency provides or purchases. 

For purchased transportation (PT) service, the report must contain data only for those services under contract. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G373
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G96
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G29
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G376
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Reporting Modules and Forms 
All agencies are required to submit data on a monthly basis. The following exhibit presents a summary of NTD 
Monthly reporting requirements. 

Exhibit 5 — Summary of NTD Monthly Reporting Requirements 

NTD Monthly Report Who Reports 

Mode Service Operated form (MR-10) All reporters without Waivers 

Ridership Activity form (MR-20) All reporters without Waivers 

Calendar Year Data 
Unlike the NTD Annual report, which covers the 12-month fiscal year period, the data in the NTD Monthly report 
covers a 12-month period corresponding to the calendar year. 

How to Report 
This section describes the following: 

• NTD identification number (NTD ID) 

• Internet reporting 

• Reporting format 

• Purchased transportation (PT). 

The NTD Identification Number 
Each reporter is assigned a unique four-digit NTD ID, which is to be used in all NTD reports and 
correspondence. The first digit of the NTD ID corresponds to the FTA Region where the reporter is located (e.g., 
9### indicates Region IX, 0### indicates Region X).  

Internet Reporting 
All required forms are completed using Internet Reporting which is accessible from the NTD website at 
www.ntdprogram.gov. Completing the Mode Service Operated form (MR-10) automatically generates the 
required Ridership Activity forms (MR-20) for the transit agency. 

This manual contains all information necessary to complete the NTD Monthly report using Internet Reporting. 
See the Internet Reporting section of this manual for specifics. FTA provides Internet Reporting user names and 
passwords to transit agencies.  

Reporting Format 
Transit agencies must submit their reports via the Internet Reporting system. A transit agency must file a 
complete report by the report due date. See the When to Report section below to determine your due date. 

General Formatting Rules: Data reported must adhere to the following rules. 

• Follow rounding directions for each form 

• Unless otherwise indicated, report data as whole numbers 

• Use four digits for year entries. 

Internet Reporting incorporates these rules, formatting data automatically when you complete a cell entry. 

http://www.ntdprogram.gov/
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Reporting Purchased Transportation  
Purchased transportation (PT) service is service provided to a public transit agency or governmental unit from a 
public or private transportation provider based on a written contract. A contractual relationship exists only if all 
the following criteria are met: 

• The seller is obligated in advance of the time the service is furnished to provide the operations for which 
the operating statistics are being reported for a specific monetary consideration. 

• A written agreement exists that specifies the contractual relationship for the time period and the specific 
service generating the operating statistics included in the NTD Annual report. 

• The written agreement is signed by authorized representatives of both the buyer and the seller, and 
should detail the services to be provided, and the nature and amount of the monetary consideration. 

Granting a transportation provider permission to operate certain services through a franchise or license does 
not, in itself, constitute PT. Also, management services contracts, in which all or some personnel or services are 
provided to manage or operate the transit agency, are not PT. Generally, the service is part of the public transit 
agency’s DO service. 

Cooperative agreements between public transit agencies or governmental units should not be reported as PT 
services. 

When to Report 

Exhibit 6 — NTD Monthly Reporting Requirements and Timeline 

Form Name Form Purpose Reporting Frequency Forms Submitted 

Mode Service Operated form 
(MR-10) 

Gives the NTD the 
information needed to 
generate the ridership activity 
forms the transit agency will 
need to complete for the 
reporting year. 

Annually (January) and when 
a mode or type of service is 
added or deleted 

One per transit agency 

Ridership Activity form (MR-
20) 

Provides the NTD with 
monthly information on 
service provided by the transit 
agency. 

Monthly One per mode / type of 
service (TOS) combination 

Monthly Reporting Due Dates 

Month Due Date Month Due Date 

January  February 29  July  August 31 

February  March 31 August  September 30 

March  April 30  September  October 31 

April  May 29 October  November 30 

May  June 30 November  December 31 

June  July 31 December  January 31 of following year 

Failure to Report or Late Report  
The NTD requires transit agencies to submit complete reports according to the due date schedule. Delinquent 
reports result from not submitting a report, submitting a late report, or not responding to validation inquires.  As a 
result, your transit agency's data may not be included in the NTD. Furthermore, FTA may declare your transit 
agency ineligible to receive any Urbanized Area Formula Program (UAF) grants during an entire Federal fiscal 
year. This ineligibility applies to all transit agencies, regardless of the size of the urbanized area (UZA) served. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G371
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G268
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G101
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G225
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G503
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A report is considered late if it is not submitted by the due date. Refer to Exhibit 3 — NTD Monthly 
Requirements and Timelines for due dates. 

The system will auto-generate a series of four e-mails sent per reporting due date: 

• A reminder will be sent to the NTD Contact on the 20th of each month. 

• The First Late Notice will be sent to the NTD Contact and CEO on the 1st of the month no report has 
been submitted. 

• A Second Late Notice will be sent to the NTD Contact and CEO on the 5th of the month if no report has 
been submitted. 

• If an agency does not submit required data by the 15th of the month, they will be added to FTA's 
Delinquent Reporter List.  NTD staff will then contact the appropriate FTA Regional Administrator, who 
will in turn contact your agency's CEO directly regarding the outstanding data. 

Please do not respond to these e-mails. These notices are auto-generated by the system the morning it is sent 
out, and should be disregarded if you submitted your report within the last few hours. 

Transit agencies are required to respond to validation inquiries. Failure to respond within the prescribed 
timeframe may result in a delinquent status, which may affect your Urbanized Area Formula Program (UAF) 
funding eligibility and the amount of funding the UZA receives. If your transit agency serves a UZA with a 
population of 200,000 or more, data will not be entered into the formula for selected formula statistics.  

Where to Report  
Transit agencies submit all NTD reports via Internet Reporting at the project's website, www.ntdprogram.gov.  

FTA assigns an NTD analyst to each reporting transit agency to assist reporters throughout the year. Please 
feel free to contact your Analyst if there are any questions, or if FTA can do anything to assist you in reporting. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/
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Internet Reporting 

Overview 
Transit agencies must use the National Transit Database (NTD) Internet Reporting system to provide their data 
via reports to the Federal Transit Administration (FTA). NTD Internet Reporting is the online means for transit 
agencies to enter, save, review and revise data, and submit reports. It provides for timely and accurate reporting 
as all tasks and requirements for the NTD can be fulfilled via this system. 

This section provides Internet Reporting information for the NTD Monthly report.  

Internet Reporting System Security 
Many measures have been taken to ensure that all data entered into the Internet reporting system are safe and 
available only to those with proper access. The NTD servers and network are secured behind a firewall. The 
website is password protected. Additionally, multiple server and database protection layers protect the database 
files. 

Detailed Instructions 

Accessing Internet Reporting 
Internet reporting is accessed from the NTD Homepage. To access Internet reporting:  

• Connect to the Internet via your Internet service provider (ISP) 

• Verify your Internet browser settings 

• Access the Internet reporting website at www.ntdprogram.gov 

• Access your transit agency’s NTD report via the Internet Reporting Login link. 

Connecting to the Internet 
You should use your ISP to connect to the Internet. Internet reporting requires a version of Internet Explorer that 
is at least a 6.x version (e.g., Internet Explorer 6.0).  If you don’t have the latest version of the browser, go to 
Microsoft.com to download the latest version free of charge. 

Verifying Your Internet Browser Settings 
You should verify that your browser is set to check for newer versions of stored pages with each visit to the 
website.  To do this in Internet Explorer, access Tools / Internet Options / General / Temporary Internet Files 
Settings / Every Visit to Page. 

http://www.ntdprogram.gov/
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The National Transit Database Website 

 

The NTD Homepage offers the following information and data for reporters and others interested in the NTD: 

• Internet Reporting Login link. 

• What is the NTD? An overview of the NTD program, milestones in transit history, how to obtain an NTD 
ID number, and an overview of the NTD reporting forms. 

Reporting Manuals 
Annual Reporting: Access to HTML and PDF versions of the current Annual Reporting Manual, an overview of 
reporting changes and highlights, reporting manual archives, etc. 

Monthly Reporting: Access to HTML and PDF versions of the current Monthly Reporting Manual, an overview 
of the reporting changes and highlights, reporting manual archives, etc. 

Safety and Security Reporting: Access to HTML and PDF versions of the current Safety and Security 
Reporting Manual, Newsletters, Safety and Security frequently asked questions (FAQ), an overview of reporting 
changes and highlights, reporting manual archives, etc. 

Rural Reporting: Access to HTML and PDF versions of the current Rural Reporting Manual and Excel 
spreadsheets, an overview of reporting changes and highlights, reporting manual archives, etc. 

Data, Publications and Reference Materials 
NTD Glossary: HTML version of the NTD Glossary of transit terms. 

NTD Reference Materials: NTD reference materials such as the Uniform System of Accounts, FTA Circulars 
and Federal Register Notices. 

Access NTD Data: HTML and downloadable PDF publications, including the Data Tables (also available as MS 
Excel self-executable files), Profiles, National Transit Summaries and Trends, as well as Annual, Monthly and 
Historical databases (MS Excel self-executable files) and other data products. 

NTD Resources 
FTA / NTD Presentations, Announcements and Updates: FTA / NTD presentations, new and useful 
information, interim updates to reporting requirements, etc. 

NTD Feedback: The mailing address, telephone number and fax number for the NTD Project site as well as an 
opportunity to provide comments or suggestions regarding the NTD Program.  
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Seminars and Training: NTD Reporting Seminars and In-house Training information and registration. 

Transit Agency Listing by Region and External Links: Contact information for transit agencies reporting to 
the NTD listed by UZA and State. Links to:  

• Federal Transit Administration (FTA) 

• FTA Safety and Security Office 

• U. S. Department of Transportation (USDOT) 

• National Transit Library 

• American Public Transportation Association (APTA) 

• Bureau of Transportation Statistics (BTS) 

• Accessibility 

Accessing the NTD Report  
Clicking the Internet Reporting Login link will open the Internet Reporting Login page. You must enter your 
user name and password to gain access to NTD Report Home.  

 

 
Levels of Access 
Internet Reporting provides four levels of access to the NTD Monthly Report:  

CEO access: Edit forms (data entry), approve Chief Executive Officer (CEO) Certification and submit report 
Contact Person access: Edit forms (data entry) and submit report (administrator) 

Editor access: Edit forms (data entry), cannot submit report 

Viewer access: View only including forms, issues, notes and correspondence. 

User Names 
The system access level is determined by the user name. The first three characters of the user name define the 
access level and the last four digits represent the transit agency’s NTD ID. There are four types of user names 
corresponding to the four access levels available within the NTD Report: 

• CEO — CEO#### 

• Contact person — NTD#### 

• Editor — EDT#### 
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• Viewer — VWR#### 

Each transit agency is e-mailed this set of user names with a password for each. Transit agencies should 
determine access within their organizations and distribute user names and passwords accordingly. 

The CEO and NTD Contact person access all reporting areas (Annual, Monthly and Safety and 
Security) from the Home tab. 

Passwords  
Please note the new password requirements for password length and complexity, as well as that the password 
expiration period has also changed from 90 to 60 days. Moreover, please note that a new 60-day account 
inactivity feature will lock accounts that have not been used at least once in a 60 day period. Accounts that 
become “locked” can be unlocked through an automatic web-based process, which will also prompt you to 
choose a new password. 

New Password requirements are as follows: 

• Password length: Passwords must be at least 12 characters and not more than 20 characters. 

• Complexity: Passwords must use 3 out of 4 character types – Lower case, Upper case, Numbers, 
Special Characters. 

• Password History: Passwords must be different from 10 previous passwords and must be different from 
any password used in the last 6 months. 

Maximum Password Age 

• 60 Day Password Expiration Period. 

Account Inactivity 

• Your account is locked if you do not login during a 60 day period. 

A user can change his / her password at any time. Refer to Sys Admin: Changing Your Password for additional 
information on this topic.  

Reporting Structure 
Monthly Reporting includes the following tabs: 

Home: The starting point when entering the NTD report. It displays the transit agency’s NTD analyst information 
and any project related announcements. 

e-File: The e-File screen provides for processing and tracking and Monthly report.  

Annual: Access to the Annual reporting modules and forms.  

Monthly: This screen provides access to the NTD Monthly reporting forms for editing and submitting your report 
to FTA. Form-by-form instructions and reporting details for the Monthly Module are included in the NTD Monthly 
Reporting Manual. The NTD contact person is responsible for submitting Monthly data to the NTD.  

Safety & Security: Access to the Safety and Security forms. 

Notes: Internet Reporting allows the transit agency to create Form Notes to provide additional information 
applicable to the overall form. Displays all the Form Notes added to the transit agency’s report.  

Issues: Displays all the Issues generated for the transit agency’s Monthly report. Issues highlight potential 
problems with specific data items (specific data which fall out of a typical range of values) and are generated 
each time the transit agency saves a form or attempts to submit the NTD Monthly report. To correct an Issue, 
the transit agency may either change the data item on the appropriate form or attach a Comment to the 
individual Issue and explain. You should use this screen to review the Issues for your report prior to submitting 
your current NTD Monthly report. All issues must be addressed before submission of the data can be finalized. 
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Reports: Print and export reports. All reports have been developed to allow the transit agency to print each form 
or report without altering print settings to fit a form on the page. The reports listed will vary depending on access 
level. 

Communications: Lists a record of the report submissions the agency has made to the NTD, including any 
comments from the agency and the review status of the report. 

Sys Admin: Change NTD passwords—CEO, NTD Contact Person, Editor and Viewer. You may only change 
your password. Should you need assistance, contact your Analyst. 

Help: Online version of the Monthly Reporting Manual. 

Home 

 
After completing the logon process you will be taken to the Report Homepage. Click the Home tab near the top 
of any screen to return to the Home tab from another area. 

e-File 

 

The e-File tab is located between the Home tab and the Annual tab. The e-File tab is a centralized area in 
which to compose, organize and track agency correspondence with the NTD program. 

Annual 

 

These Annual Module reporting forms are completed by the NTD contact person according to the requirements 
established in the Annual Reporting Manual. 
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Safety & Security 

 
This tab provides access to the Safety and Security Module forms for editing and submitting your reports to 
FTA.  Form-by-form instructions and reporting details for the Safety and Security Module are included in the 
Safety and Security Reporting Manual. 

Help: Obtaining More Information 

 

Click on the Help tab to display the Help screen. The Help screen provides access to the 2014 Monthly 
Reporting Manual for additional help in completing the NTD report forms. The Help screen displays the table of 
contents for the Monthly Reporting Manual with links to each section of the manual. 

Communications Summary: Viewing a History of Correspondence with the NTD 

 

The Communications tab gives transit agencies a centralized area in which to view past correspondence with 
the Federal Transit Administration’s (FTA) National Transit Database (NTD) program. In addition, the 
correspondence view can be filtered to show only certain processes or communication types. 

Sys Admin: Changing Your Password 

 

The Sys Admin screen provides the ability to change your NTD password. 

All passwords expire every sixty days. You can change your password at anytime on the Sys Admin screen by 
specifying your current and new password. To be valid, a password must be between 12 and 20 characters long 
and contain at least three out of four character types (Upper case, Lower case, Numbers, Special characters). 
Passwords cannot contain spaces and are case-sensitive. If you do not update your password within the sixty-
day term, you will be forced to update your password when you first access the system once the sixty-day 
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period has expired. The screen is similar to the one available on the Sys Admin screen and the same password 
rules apply. 

Monthly Ridership 

 

Click on the Monthly tab to locate the Monthly forms that your agency is required to complete.  

At the beginning of each calendar year the Monthly tab only provides access to the Mode Service Operated 
form (MR-10). 

When you have completed, reviewed and saved the Mode Service Operated form (MR-10), the NTD will 
automatically generate the Ridership Activity form(s) (MR-20) for each mode / type of service your agency 
operates. 

Issues 

 

Reporters can access the Issues screen by clicking the Issues tab. This screen highlights potential problems 
with specific data items identified through the NTD validation process. 

The NTD validation process ensures that NTD reporting requirements are met and that the reported data fall 
into reasonable ranges and make sense. 

NTD Monthly Ridership validation is an interactive, iterative process with two alternating phases: 

• Pre-submission validation – automatic system validation checks performed prior to submission of the 
NTD Monthly report. 

• Post-submission validation – review by your assigned NTD analyst after submission of the NTD Monthly 
report. 

In support of the NTD validation process, FTA has assigned an NTD analyst to each transit agency. NTD 
analysts are available to assist transit agency personnel and may be contacted at the NTD Help Desk. Direct 
contact information for each analyst is available from the Home tab in the Announcements section (NTD Contact 
Information) Refer to the exhibit in the Introduction section of this manual for general NTD contact information 
(mailing addresses, hours of operation, etc.). 

Reports 
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Click on the Reports tab to display the Reports screen. This screen provides access to several reports available 
to assist you in preparing your NTD Monthly report. Most notably, the Ridership Activity Summary Report. We 
suggest that you run this report after saving but prior to submitting your data each month. Please refer to the 
section on Printing for instructions on viewing, printing and exporting a report. To open a report you should click 
the corresponding link on the Reports screen and the report will open Adobe Acrobat Viewer. You can print the 
report by clicking the Print button  in the upper left corner of the viewer and click the Okay button on the 
resulting Print window. 

You can also review selected reports associated with prior submissions for the current Report Year (i.e., 2014) 
and prior Report Years i.e., 2012 and earlier). To view current or prior year’s reports, click on the Report drop-
down menu located above the tab line, and select the year and report stage that you wish to view. 

Notes: Providing Additional Information 

 

Click on the Notes tab to open the Notes Summary screen. Internet reporting allows the transit agency to 
create a Form Note for information applicable to the overall form. 

Creating a Form Note 
To create a form note, click on the Add Form Note link at the top right of the form you are editing or viewing. 
Internet reporting will take you to the Form Notes screen for the specific form. Internet reporting pre-fills the 
mode and TOS (if applicable) for which the note is created, but reporters must complete the note comment. 

To save a form note, click on the Save button at the bottom of the screen. To return to the form being edited 
without saving the note, click on the Cancel button. 

Reviewing Form Notes 
Click on the Form Notes tab to view the Form Notes screen. You can review the form notes associated with a 
specific form or all form notes for the report. While working in a form click on the Form Notes tab to display the 
Form Notes screen for the form. The form name, mode and TOS will be displayed just beneath the tabs.  

You also can review form notes associated with prior submissions for the current Report Year (i.e., 2014) and 
prior Report Years (i.e., 2012 and earlier). To view current or prior year’s form notes, click on the Report drop-
down menu located above the tab line, and select the year and report stage that you wish to view. 

Editing Notes 
While you are in the Working Data report stage, you can edit a form note after it has been created by clicking 
on the Edit Note link in the far right column on the Form Notes screen. Once the NTD report is submitted the 
notes are frozen and cannot be edited. Notes can only be edited while in the report status is Working Data 
which is displayed at the top of screen in the Report menu. 

Notes are frozen with each submission. If the report is sent back to the transit agency and notes are 
reviewed or added, the previously submitted notes will not be affected. 

Printing Form Notes 
You can print all form notes from the Reports tab by clicking the Notes and Issues Report link. 



2014 Monthly Ridership Reporting Manual 

Internet Reporting — 24 
 

Tips for Using Internet Reporting 

Navigating Between Screens 
Do not use the browser Back and Forward buttons to navigate between screens. Instead, use the Internet 
Reporting system buttons, tabs and links.  

Saving a Form 
A Save button is provided at the bottom of each Internet reporting form. When entering information into a form, it 
is strongly recommended that you save the form frequently. This will prevent the loss of data if your Internet 
connection is unexpectedly lost. 

Also, Internet reporting has an automatic time-out feature that will log users off of the system after a period of 
inactivity. It is strongly recommended that you save your work every 15 minutes. Otherwise, there is a risk that 
the next action you take on the system will result in the closure of the screen displayed in your browser and the 
loss of any data that you had not saved. 

Printing 

Printing a Form Report from a Form Screen 
Click on the Print button at the bottom of the Form screen to display the report in Adobe Acrobat Viewer; then 

click the Print button  in the upper left corner of the viewer and click the Okay button on the resulting Print 
window.



2014 Monthly Ridership Manual 

Monthly Reporting Module Forms — 25 
 

Monthly Reporting Module Forms 

Mode Service Operated Form (MR-10)  

Overview 
The Mode Service Operated form (MR-10) is used to identify the modes and types of service (TOS) operated by 
the transit agency. Internet Reporting uses this information to generate the appropriate ridership activity forms 
for the transit agency. This form is completed once at the beginning of the calendar year and revised only if 
there is a mode added or discontinued during the reporting period. 

The Mode Service Operated form (MR-10) is completed once at the beginning of the calendar year and revised 
only if there is a new mode and type of service (TOS) added or discontinued during the reporting period. This 
form is used to identify the modes and types of service (TOS) operated by the transit agency. Internet Reporting 
uses this information to generate the appropriate ridership activity forms for the transit agency.  

This form is required for all transit agencies, except those agencies with an approved Small Systems Waiver (30 
or Fewer Vehicles). 
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Mode Service Operated Form (MR-10)  

Reporting Requirements and Thresholds 
All agencies must complete the Mode Service Operated form (MR-10) annually. The exceptions are transit 
agencies with a Small Systems Waiver (30 or Fewer Vehicles), who need not complete this form. Forms will not 
be generated for agencies that have an approved Small Systems Waiver (30 or Fewer Vehicles). 

What Has Changed from Prior Year 
1. There are no changes from the prior year. 

Approach 
The Mode Service Operated form (MR-10) is used to identify the modes and types of service (TOS) operated by 
the transit agency. The data reported on this form is used by Internet Reporting to generate the appropriate 
Ridership Activity forms (MR-20) for the transit agency for the calendar year. 

Internet Reporting prepares one set of monthly forms for each mode / type of service (TOS) operated by the 
transit agency.  

Detailed Instructions 
When the Mode Service Operated form (MR-10) is accessed, use the check boxes to indicate which 
modes/types of service (TOS) your agency operates. Once the form has been saved and submitted, the check 
boxes are no longer active. 

If you need to add, delete or end a mode or type of service (TOS) during the report year, use the Add / Delete 
Mode / Type of Service button at the bottom of the screen. Common reasons for a mode / type of service being 
added, deleted or ended: 

• A mode / type of service (TOS) was discontinued,  

• A mode / type of service (TOS) was inadvertently reported / omitted on the Mode Service Operated form 
(MR-10), or 

• A new mode / type of service (TOS) began operation during the year. 

Completing the Mode Service Operated form (MR-10) 

Mode  
Transit agencies operate one or more modes of transit service. A mode is a system for carrying transit 
passengers described by specific right-of-way (ROW), technology and operational features. All modes 
recognized by the NTD are described in detail in the Reference section at the beginning of this document.  

Multi-Modal Vehicles 
If a vehicle is used for more than one mode, report it under each mode for which it is used and describe the use 
of the vehicle using the Add Form Notes link.  

When all data have been entered into the form and verified for accuracy, click on the Submit Report button to 
generate the required forms.  

  

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G266
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G266
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Editing the Mode Service Operated form (MR-10) 

Add / Delete Mode / Type of Service 

 

If the agency adds, deletes or discontinues a new mode / type of service (TOS) (directly operated (DO) or 
purchased transportation (PT)), click on the Add / Delete Mode / Type of Service button at the bottom of the 
form. A new screen will appear. Click on either the Add or Delete Mode / Type of Service button depending on 
whether a mode / type of service (TOS) is being added, deleted or discontinued. Select the mode and type of 
service from the Drop-Down boxes for the correct line and enter either the new service start date or the out of 
service date. Save the form by clicking on the Save button.  

Line by Line Instructions 

Completing the Mode Service Operated form (MR-10)  
From the Monthly tab, click on the Mode Service Operated form (MR-10) link.  

Form Level Help: Click on the Help tab at the top of the screen for form level help. A form note can be attached 
to any form. Use the Add Form Note link to include relevant information for a specific field, for the entire form or 
for multiple forms. Click on the Add Form Note link at the top of the screen and enter your note on the Notes 
screen. You can review and / or edit a form note from the Notes tab. Form notes can be edited or revised until 
the form is saved after which new form notes can be added.  

Saving or Closing the Form 
Click on the Submit button to save and submit the form. Click on the Close button to close the form without 
saving.  

Line by Line Instructions for Completing the MR-10 Form 
Lines 1 - 17, column a: Directly Operated (DO) - Vehicles Operated in Maximum Service (VOMS): Select the 
Check-Box (es) to indicate which modes are directly operated by the transit system. Select Other if none of the 
above apply and describe the Other mode in the Describe Other field that appears on the form. 

Lines 1 - 17, column b: Purchased Transportation (PT) - Vehicles Operated in Maximum Service (VOMS): 
Select the Check-Box(es) to indicate which modes are directly operated by the transit system. Select Other if 
none of the above apply and describe the Other mode in the Describe Other field that appears on the form. 

Editing the Mode Service Operated form (MR-10)  

Adding a Mode / Type of Service 
From the Monthly tab, click on the Mode Service Operated form (MR-10) link. 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G123
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G376
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Click on the Add / Delete Mode / Type of Service button to enter new service. 

In the new window, click on the Add Mode / Type of Service button. 

Column a: Mode. Select the mode that your agency has begun operating from the Drop-Down menu. 

Column b: Type of Service. Select the type of service (TOS) that your agency has begun operating from the 
Drop-Down menu. 

Column c: New Service Start Date. Enter the date that the new mode / type of service (TOS) began operating. 

Discontinuing a Mode / Type of Service 
From the Monthly tab, click on the Mode Service Operated form (MR-10) link. 

Click on the Add / Delete Mode / Type of Service button to delete an existing service. 

In the new window, click on the Delete Mode / Type of Service button. 

Column a: Mode. Select the mode that your agency has stopped operating from the Drop-Down menu. 

Column b: Type of Service. Select the type of service (TOS) that your agency has stopped operating from the 
Drop-Down menu. 

Column c: Out of Service Date. Enter the date that the mode / type of service (TOS) was taken out of service. 

Deleting a Mode / Type of Service 
From the Monthly tab, click on the Mode Service Operated form (MR-10) link. 

Click on the Add / Delete Mode / Type of Service button to delete an existing service. 

In the new window, click on the Delete Mode / Type of Service button. 

Column a: Mode. Select the mode that was incorrectly entered from the Drop-Down menu. 

Column b: Type of Service. Select the type of service (TOS) that was incorrectly entered from the Drop-Down 
menu. 

Column c: Out of Service Date. Enter January first of the year you wish to completely delete the Mode / TOS 
from. 
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Ridership Activity Form (MR-20)  

The Ridership Activity form (MR-20) collects monthly information regarding transit service provided by the 
agency. These data provide FTA with monthly trends in passenger usage and service levels.  

This form is required for all transit agencies, except those agencies with an approved Small Systems Waiver (30 
or Fewer Vehicles). 

 

 

Overview 

Reporting Requirements and Thresholds 
Monthly ridership activity information is collected by mode and type of service (TOS). These data provide FTA 
with monthly trends in passenger usage and service levels.  

Reporters must enter their data by the end of the month following the month for which data is being reported, 
i.e., January data is submitted by the last day of February.  

What Has Changed from Prior Year 
1. There are no changes from the prior year. 

Approach 
There are two Ridership Activity forms (MR-20) tailored for: 

• Rail 

• Non-rail 

The Ridership Activity form (MR-20) is used to report monthly data by mode and type of service (TOS) for the 
revenue vehicles used to provide transit service. 

Agencies must report all service for the month – this includes weekend service and non-regular service days. 

The data include: 

• Service consumed (unlinked passenger trips (UPT)) 

• Service supplied (actual vehicle (passenger car) revenue miles (VRM) and hours (VRH)) 

• Passenger cars in operation / vehicles operated in maximum service (VOMS) 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G266
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G498
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G399
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G502
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G21
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G20
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The data items in this form are similar to the annual data reported on the Service form (S-10). The data reported 
on the Ridership Activity form (MR-20) must be consistent with the annual data reported in the Service form (S-
10). 

Detailed Instructions 
Data fields for any given month will not appear until that month has ended. As the form is being completed, 
changes should be saved by clicking the Save button frequently. 

When all data have been entered for a particular month and the data have been verified for accuracy, the 
month’s data should be date stamped by clicking the Submit button at the end of the row. The date under the 
Submit Date column should reflect the current date. Next click on the Save button at the bottom of the form to 
save the data. If you do not click on the Save button at the bottom of the form, the data will not be saved. Any 
change to a prior month’s data takes effect only after the Submit button is clicked and a submit date shows in 
the column for Submission date. 

To close the form, click on the Close button to return to the Monthly tab. The submit date is the date that the 
user last updated and saved data for a particular month. Monthly data can be updated, date stamped and saved 
until the end of February of each year, after this time revisions must be done through your Monthly analyst. 

To revise data for prior months, enter the data in the appropriate cell for the month being revised. Click on the 
Submit button at the end of the row. The date under the Submit Date column should reflect the current date. 
Next, click on the Save button at the bottom of the form. To close the form, click on the Close button to return to 
the Monthly tab. 

Unlinked Passenger Trips  
Unlinked passenger trips (UPT) are the number of passengers who board public transportation vehicles. 
Passengers are counted each time they board vehicles no matter how many vehicles they use to travel from 
their origin to their destination. 

FTA requires 100 percent counts if available and reliable. One hundred percent counts include Automatic 
Passenger Counting (APC) systems, fare box counts, manual counts, and any other automated system of 
counting transit passengers. If 100 percent counts of any type are not available or reliable, FTA allows reporters 
to apply a methodology developed for estimating monthly trips.  This methodology does not need to be the 
same as the one used in annual reporting. However, the two methodologies cannot be biased in relation to each 
other. 

Actual counts (100 percent sample) involve counting passengers each time they board a vehicle. This method is 
generally applicable to smaller systems, but its use is not precluded by a system’s size.  

If the transit agency uses a sampling method, the total unlinked passenger trips (UPT) for a specific month 
should be estimated using the sample data collected during the month and the same procedure that the transit 
agency uses to estimate annual unlinked passenger trips (UPT). This approach may not meet FTA’s confidence 
and precision levels for annual data (+-10% precision for a 95% confidence level), but does meet FTA’s 
requirements for a good faith effort for reporting monthly data on the Ridership Activity form (MR-20). 

If the transit agency changes its sampling procedure, it should revise its reported unlinked passenger trips 
(UPT) for the current year and the prior year using the new methodology. The transit agency should contact 
their Validation analyst for assistance in reporting the revised estimates for the prior year. 

Other estimation methods not necessarily based on sampling can also be used. For example, monthly fare box 
revenues can be used, provided that bias correction factors are factored into the method to account for trips for 
which no fare box revenues are recorded, or a large number of intra-modal transfers skews the relationship of 
trips and fare box revenues.  

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G502
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G373
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Exhibit 7 — Transit Agency Makes 100 Percent Count for Bus (MB) to Calculate the Total Unlinked Passenger Trips 
for the Month 

Day Number of Days in Month Total Unlinked Passenger Trips 

Weekday 21 46,956 

Saturday 5 5,987 

Sunday 5 3,125 

Solution 31 56,068 

The total unlinked passenger trips for weekday, Saturday, and Sunday are summed to arrive at the total unlinked passenger trips for 
the month. 

The transit agency reports 56,068 for total unlinked passenger trips (UPT) for the month. 

 

If the transit agency uses an estimation method to report the data and not 100 percent counts, this method does 
not need to be the same procedure that the transit agency uses to estimate annual unlinked passenger trips 
(UPT). However, the two methods cannot be biased in relation to each other. The annual data and the 
cumulative monthly data for the agency’s fiscal year should be very close, if not identical.  

Actual Vehicle (Passenger Car) Revenue Hours and Miles  
Actual vehicle revenue hours (VRH) and miles (VRM) are incurred when non-rail service is available to the 
general public. These are the miles and hours traveled by vehicles in carrying passengers, plus 
layover/recovery time. It does not include the miles and hours for items such as deadhead, charter services, 
school bus service, operator training or maintenance testing. For rail service, the data are reported in terms of 
passenger car revenue hours and miles. 

Vehicles Operated in Maximum Service 
This is the number of revenue vehicles/passenger cars operated to meet the maximum service requirement 
during the month. In most instances, this is the number of scheduled vehicles/passenger cars since most transit 
agencies have sufficient vehicles/passenger cars to operate the scheduled service. Vehicles operated in 
maximum service (VOMS) / passenger cars in operation exclude atypical days or one-time special events. 

This data item is different than the vehicles operated in annual maximum service (VOMS) that is reported on the 
Service form (S-10). The difference between the forms is the time period used in the definition— a month in the 
Ridership Activity form (MR-20) and a fiscal year in the Service form (S-10).  

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G20
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G21
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G284
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G226
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G110
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G81
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G420
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G385
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G345
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G346
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G399
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G524
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Form Notes 

 
Reporters can attach a Form Note to any form to explain unusual circumstances or data discrepancies that 
impact the data being submitted to the NTD. Use the Add Form Note link to submit relevant information for a 
form. Click on the Add Form Note link at the top of the screen and enter your note on the Notes screen. You 
can review and / or edit a Form Note from the Notes tab. 

Data Validation Tools and Validation Checks 
If there is missing data when a reporter clicks the Submit button, the NTD system will generate an alert and the 
form will not be submitted. The agency is required to provide all missing data in order to submit the NTD 
Monthly report. 

Starting in the 2011 calendar year, automated validation checks were incorporated into the Monthly module.  
You can access these validation checks from the Issues tab. You will be required to either correct the data or 
explain why the data should be acceptable in order to submit your monthly report.  In addition, a report 
comparing Monthly data with the most recent submitted Annual data is available from the Reports tab. 

Agencies are encouraged to make changes to the data for any month(s) in the current calendar year, as 
necessary, to ensure that the best available data is reported. Changes can be made without requesting 
permission from FTA.  However, a change to a prior year’s data requires authorization from FTA. 

Issues  
Reporters can access the Issues screen by clicking the Issues tab. This screen highlights potential problems 
with specific Monthly Ridership data points identified through the NTD validation process. 

The NTD validation process ensures that NTD reporting requirements are met and that the reported data fall 
into reasonable ranges and make sense. 

NTD Monthly Ridership validation is an interactive, iterative process with two alternating phases: 

• Pre-submission validation – automatic system validation checks performed prior to submission of the 
NTD Monthly report. 

• Post-submission validation – review by your assigned NTD analyst after submission of the NTD Monthly 
report. 

Pre-Submission Validation 
Reporters access the Issues screen by clicking the Issues tab. This screen highlights potential problems with 
specific data items identified through basic NTD validation checks.  When a reporter enters MR-20 form data or 
revises existing entries and clicks the Save or Submit button, the system runs a series of automated validation 
checks.  If any of the data on the MR-20 form falls outside of expected ranges, the system will notify the user 
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and the Submit Date field will not populate.  These issues may include but are not limited to identical data 
submitted for previous months, entries that include zero values or entries that include figures outside the normal 
expected ranges.  

The NTD validation process ensures that NTD reporting requirements are met and that the reported data fall 
into reasonable ranges and make sense. These validation checks are designed to flag: 

• Monthly variations in the data outside the ranges derived from the historic data reported for that service mode by all 
agencies. 

• Identical data for successive months. 

Upon saving your most recent report, Internet reporting will notify you if you have issues that you need to 
address. You will be required to either correct the data or explain why the data should be acceptable in order to 
submit your monthly report. 

Internet reporting automatically performs issue checks after a form is saved. The issue checks help you assess 
the completeness and reasonableness of your data prior to submission to FTA. You can access the complete 
listing of issues for the specific form by clicking on the Issues tab while viewing the form.  

Prior to the original submission, issues are deleted as you correct the data and resave the forms. Issues that are 
explained but not corrected will no longer be marked as active but will not be deleted. Important issues that 
remain when the NTD Monthly report is submitted will continue to be available for review on the Issues tab. Any 
corrections or explanations subsequent to the original submission will be recorded and are available for review 
by you and the NTD staff. 

Post-Submission Validation by NTD Analysts 
The issues undergo a series of reviews by NTD staff during which the issue status may be changed. At each 
stage, you should revise forms as necessary, review issues, respond to the issues, save and re-submit the 
report.  

 
You can view exactly what issues have been flagged in the Issues tab.  The issues provide reporters with the 
Mode/TOS and month in question, as well as the questionable data point and possible resolution activity. 
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Resolving Issues 
There are two ways to address identified issues and submit data.  If the data has been entered incorrectly, 
reporters should change the values directly on the MR-20 form to reflect the proper numbers, save and submit 
the form.  However, if the data is entered correctly but nonetheless result in issues, they can be resolved by 
adding comments that explain the issue.  To add a comment, click on the Add Comments link for any active 
issue.  A separate comment must be supplied for each issue.  Even though adding a comment will allow a 
reporter to submit the MR-20 form, the issue is not considered permanently closed until the NTD analyst has 
reviewed and accepted the explanation. 

 

Once a reporter has resolved all Monthly Ridership and/or has added a comment to explain each active issue, 
the reporter can click the Submit button on the MR-20 form.  Reporters can confirm successful submission by 
verifying that the Submit Date field has been populated with the current date.  Data is not considered submitted 
until the Submit Date field is correctly populated.  Any month on the MR-20 that does not have a populated 
Submit Date field by the data submission deadline will be considered outstanding. 

Line by Line Instructions 

Completing the Ridership Activity form (MR-20) 
From the Monthly screen, click on the Ridership Activity form (MR-20) link for the applicable mode / type of 
service (TOS). 

Complete the Ridership Activity form (MR-20) following the instructions in this section. Data fields for future 
months will not appear until the 1st of the following month (i.e., February will not be available until March 1). 
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Form Level Help 
Click on the Help tab at the top of the screen for form level help. A form note can be attached to any form. Use 
the Add Form Note link for relevant information to a specific field, to the entire form or to multiple forms. Click 
on the Add Form Note link at the top of the screen and enter your note on the Notes screen. You can review 
and / or edit a form note from the Notes tab.  Reporters can edit or revise Form Notes until the form is Date 
Stamped and saved after which new form notes can be added. 

Saving and Closing the Form 
To save your data, click the Save button at the bottom of the form. If you do not click the Save button prior to 
closing the Ridership Activity form MR-20, your data will be lost. This procedure is followed each month, or 
each time you return to a prior month to revise data.  

Line by Line Instructions for Completing the MR-20 Form: Rail Modes  
Lines 01-12, column a: By Month - Unlinked Passenger Trips (UPT). Enter the number of unlinked passenger 
trips (UPT) (need not be audited). 

Lines 01-12, column b: By Month - Passenger Car Revenue Hours. Enter the number of actual passenger car 
revenue hours (data need not be audited). 

Lines 01-12, column c: By Month - Passenger Car Revenue Miles. Enter the number of actual passenger car 
revenue miles (data need not be audited). 

Lines 01-12, column d: By Month - Passenger Cars in Operation. Enter the number of passenger cars in 
operation (data need not be audited). 

Lines 01-12, column e: By Month - Submit. When all data have been entered for a particular month and the data 
have been verified for accuracy, the month's data should be date stamped by clicking the Submit button for that 
row. The submit date is the date that the user last updated data for a particular month. This procedure is 
followed each month, or each time you return to a prior month to revise data. 

Line by Line Instructions for Completing the MR-20 Form: Non-Rail Modes 
Lines 01-12, column a: By Month - Unlinked Passenger Trips (UPT.) Enter the number of unlinked passenger 
trips (UPT) (need not be audited). 

Lines 01-12, column b: By Month - Vehicle Revenue Hours (VRH). Enter the number of actual vehicle revenue 
hours (VRH) (data need not be audited). 

Lines 01-12, column c: By Month - Vehicle Revenue Miles (VRM). Enter the number of actual vehicle revenue 
miles (VRM) (data need not be audited). 

Lines 01-12, column d: By Month - Vehicles Operated in Maximum Service (VOMS). Enter the number of 
vehicles operated in maximum service (VOMS) (data need not be audited). 

Lines 01-12, column e: By Month - Submit. When all data have been entered for a particular month and the data 
have been verified for accuracy, the month's data should be saved by clicking the Save button at the bottom of 
the form, and then date stamped by clicking the Submit button for that row. The submit date is the date that the 
user last updated data for a particular month. This procedure is followed each month, or each time you return to 
a prior month to revise data. 

Monthly Ridership Data Reporting and the Small Systems Waiver (W-30) 

Overview 
Transit agencies with an approved Small Systems Waiver form (W-30) do not report Monthly Ridership data on the reporting 
forms on the Monthly Ridership tab.  Instead, FTA estimates Monthly Ridership data for all agencies during Fiscal Years with 
Small Systems Waivers.   
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Moving from full Annual Report to Small Systems Waiver 
Monthly Ridership reports (MR-20) are no longer required as of the first month of the Small Systems Waiver. In order to 
discontinue Monthly Ridership reporting, “delete” all modes as of the first of the month starting the new Fiscal Year using the 
Add/Delete Mode button in the MR-10 Mode Service Operated form. If Monthly Ridership reports have already been 
submitted for months in the new Fiscal Year including the Small Systems Waiver, there is no need to delete reports already 
submitted. Please ensure that Monthly Ridership reports have been submitted for all months prior to the start of the Small 
Systems Waiver.  

Moving from Small Systems Waiver to Full Annual Report 
Monthly Ridership reports (MR-20) are required as of the first month of the new Fiscal Year without a Small Systems Waiver. 
In order to begin Monthly Ridership reporting, add all modes as of the first of the month starting the new Fiscal Year using 
the Add/Delete Mode button in the MR-10 Mode Service Operated form. 

  

Exhibit 8 - Annual Report Submission 

Monthly ridership data is required until start of the period of time covered by the agency’s fiscal year with a Small Systems Waiver.  
The following table depicts the fiscal period, the date of waiver deadlines and the due date for the Annual Report. 

Fiscal Year End January 1 – June 30 July 1 – Sept 30 Oct 1 – December 31 

Waiver Deadlines August 31 November 30 February 28 

Report Due Date October 29 January 31 April 29 
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Questions 
If you have any questions regarding Monthly Reporting, contact your Analyst.  If you are unsure of the name of your analyst 
or their contact information, contact the NTD Helpdesk at: 1-888-252-0936 or by email at: NTDhelp@dot.gov. 

mailto:NTDhelp@dot.gov
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